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Foreword

Educators at nearly every grade level are examining the tools required to produce
the 21st century skills today’s students need to succeed in their schools, workplaces,
and civic lives. One device that many educators are already using in their curricula
with great results is the iPod. Teachers are using iPod to support second language
learners, address the needs of diverse learners, motivate struggling readers, as well
as to support their own professional development. And, because the iPod is
portable, teachers and students can learn where and when they want.

iPod makes it possible to deliver large quantities of content—such as
comprehensible language—to students in an efficient and convenient manner.
Today, one out of every five K-12 students in the United States comes from a home
in which a language other than English is spoken. This situation presents additional
challenges for educators. With iPod and iTunes, teachers can now enhance audio
with pictures and video, making important visual connections to the second
language being learned.

Teachers and students can use the iLife suite of digital authoring applications
included on every new Mac, such as iMovie HD and GarageBand, to create their own
iPod content. iPod and iLife are a great way for educators to create, organize, and
distribute content, all of which adds new and exciting dimensions to learning. And
iTunes provides an easy way to store, organize, and purchase content for the iPod.

The seamless integration of iPod and iTunes makes it easy for teachers to provide
textual, auditory, and visual resources to reach all types of learners, particularly those
students who need extra assistance. Using iPod in the classroom can also assist in
helping students master content standards. For example, iPod can help students
achieve oral reading fluency—an important bridge between word decoding and
reading comprehension.

Capturing the attention of today’s students can be challenging, and using iPod with
audiobooks is yet another way to get students engaged in learning. Audiobooks
motivate and create interest in the physical texts themselves. Audiobooks can be
readily used with iPod—using them in this way is like having a reader with the
student at all times.

And what about the many administrative functions you must perform and keep
track of as a teacher? iPod is also a wonderful device to help you to organize and
manage routine tasks in your classroom. You can keep your calendar, contacts, and
files on an iPod, as well as record voice memos to yourself or audio assessments of
your students using an optional voice recorder.
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This Getting Started guide is designed to help you create an environment where
learning really is anywhere, anytime. You’ll learn the basics of iPod and iTunes so that
you’ll be familiar with the operation and interface. Whether for one user or an entire
class, you’ll also discover how to effectively set up, maintain, and manage iPod in the
classroom. You’ll even explore several lesson plans and curriculum ideas for using
iPod as a part of digital projects in your classroom. Because Apple products have a
similar, easy interface, it won’t take you long to begin using these innovative tools
with your students.

The power to effectively teach and learn is in the hands of you and your students,
both literally and figuratively, when you use Apple’s iPod and iTunes in your
classroom! 

Kathy Shirley
Technology and Media Services Director
Escondido Union School District
Escondido, California

Foreword 5



Getting Started: A guide for using iPod and iTunes for teaching and learning

Overview

Why iPod and iTunes for Education?
Innovative educators are using iPod as a powerful educational tool in the effort to
meet students’ academic needs and to help them achieve 21st century literacy. iPod
and iTunes are the perfect combination for delivering many types of content.
Interdisciplinary lessons that link music, art, and literature, as well as math modeling
and virtual dissections are easy to put into students’ hands. Addressing students
with special needs, such as visual and auditory impairments, is also made simple
with the use of iPod and iTunes. Much of the educational potency of iPod stems
from its portability and its capacity to both enhance teaching and learning at school
and extend it beyond the classroom.

• The iPod is a portable learning tool—an electronic classroom, allowing anywhere,
anytime access to speeches, audiobooks, and lectures. Its portability also means that
students can readily share their work with family members.

• Because the iPod is so portable, it “time shifts” education, allowing stored content to
be listened to or viewed at a time more convenient for the learner.

• iPod and iTunes are tools for delivering differentiated curriculum to learners at
teachable moments at different times and locations, allowing teachers to expand
learning beyond the traditional boundaries of class time. This is especially important
for students performing below grade level, as a major challenge educators face in
helping these students achieve grade-level proficiencies is accelerating and
extending their learning time beyond the school day.

• iPod and iTunes allow enhanced audio communication, increased learner control
over content, and the ability for the learner to multitask.

• iPod gives educators a way to easily harness the power of audiobooks for students.
Because listening is fundamental to learning all the other language arts (reading,
writing, and speaking), students who are better listeners are also better learners. In
particular, students who comprehend well through listening do the same when
reading. Audiobooks delivered via iPod and iTunes model fluid phrasing, proper
word pronunciation, and can be replayed as often as a student desires.

• Another big plus is the motivation factor of iPod and iTunes in the classroom. They
meet the mobile and media-rich learning styles of today’s students and allow them
to learn as they live—on the go.

Many teachers are using iPod to help students learn a foreign language, become
better readers, provide visual reinforcement of mathematics and science concepts,
and support the diverse needs of today’s learners. The opportunities are endless for
teachers and students to seamlessly create, organize, distribute, and access all kinds
of learning materials.
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Note: This guide introduces you to using iPod with a variety of content in the
classroom. It assumes you are using the iPod with video capability. If you’re using an
iPod that cannot play video, such as iPod nano or an older model of the iPod, not all
of the discussion in this guide will apply.

What Are iPod and iTunes?
This section introduces you to both the iPod player itself as well as to iTunes, the
software used with iPod. For information about how to turn the iPod on and off and
navigate the contents of an iPod, see “Appendix: iPod 101” later in this guide.

iPod at a Glance
iPod is an easy-to-use portable media player for storing and playing audio, images,
and video. iPod is most popularly known as a music player—it is that and more as
an instructional tool in the hands of students and teachers. iPod can also be used as
an external data storage device to store photos, notes, calendars, and contact files,
as well as other files you might keep on a portable hard drive. iPod can also be
connected to a TV or projection device (with an added AV cable) to display files
such as slide presentations. And, with the addition of a small third-party voice
recorder, iPod can be used to record any kind of audio file—from class lectures to
poetry readings. (For more information, see “Using iPod for Voice Recording” and
“Accessorizing iPod” later in this guide.)

Loading files, photos, songs, and video content onto an iPod is simple. The iPod dock
connector on the bottom of the iPod lets you connect, sync (load files onto the
iPod), and recharge quickly using the included USB cable.

Overview 7
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The iTunes library is where iTunes stores your collection of audio and video files on
the computer. To sync your iPod, you first open the iTunes software on a computer
and add audio and video files to the iTunes library. Next, you connect the iPod to
the computer, and the files from the iTunes library on that computer are synced, or
copied, to the iPod. (For more information, see “Adding Content to iPod Using
iTunes” later in this guide.)

For more information and tutorials, visit:
www.apple.com/support/ipod101

For detailed information about the specifications of each iPod model, including hard
drive size, battery duration, and included accessories, visit:

www.apple.com/ipod/specs.html

iTunes at a Glance
iTunes is an application for organizing and playing digital audio and video content.
It has an incredibly easy-to-use interface for managing the content on an iPod. iPod
and iTunes work seamlessly together to synchronize music, video, and other files
available on a computer with iPod. This can be set up to happen automatically so
that when an iPod is connected to a computer, the iTunes library is automatically
synced (copied) to the iPod. iTunes can also be used to connect to the iTunes Store
to download purchased music, television shows, feature-length movies, and free
podcasts. iTunes is compatible with both Mac and PC and comes pre-installed on
every Macintosh computer. It is available as a free download at
www.apple.com/itunes/download.

Adding content to your iTunes library is as easy as importing a music CD or
downloading content from the iTunes Store. When you open iTunes, the main iTunes
window displays the contents of the iTunes library. The Source list on the left of the
iTunes window gives you easy access to all the content you have stored within
iTunes. The iTunes library can hold a collection of digital audio and video files,
including music imported from a CD, podcasts subscribed to from the iTunes Store,
or other audio and video content that has been imported or purchased from the
iTunes Store. As an iTunes collection grows, you can maintain multiple libraries for
classroom use.

When you connect an iPod to your computer or insert a CD, an icon for it appears in
the Source list below Devices. When you click the icon of the iPod or the CD, iTunes
displays its contents. You can also define settings for how you want to use the iPod
by clicking the iPod icon in the Source list and then making selections from the tabs
that appear. For example, an option in the Summary pane allows you to use the
iPod like a hard disk. For more information about these settings, see “Adding
Content to iPod Using iTunes” later in this guide.
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Using iTunes, you can organize songs and other items into lists called playlists. For
example, you can make a playlist for a specific student project or a playlist for a
particular class. The Source list displays all of the playlists in the iTunes library. You
can create your own playlists to organize the content in iTunes in the best way for
you and your students. Playlists can contain individual songs, entire albums,
podcasts, audiobooks, speeches, or videos. For example, if the class is studying the
American colonies, you could create one playlist with songs from that time period
and specific episodes from the Colonial Williamsburg podcast to share with
students.

You can also create Smart Playlists that automatically update according to criteria
you set—for example, podcasts you’ve added in the last month. Note that files are
not duplicated each time you place them in a playlist. They are simply aliases, or
pointers, to the actual files in your iTunes library.

From the iTunes window, you go to the iTunes Store by clicking iTunes Store in the
Source list. (An Internet connection is needed.) You can use the iTunes Store to
locate and download podcasts, music from around the world, audiobooks, speeches,
and more. As you download free or purchased items, iTunes automatically adds the
titles to your library. Downloading starts when you click Subscribe, Get, or Buy Now
in the iTunes Store.

For more detailed information and tutorials about iTunes, visit:
www.apple.com/support/ipod101/tunes

Overview 9
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Education Content for Use with
iPod and iTunes

iPod and iTunes provide a great way for you and your students to access valuable
educational resources. This may be content from existing sources, such as podcasts,
audiobooks, movies, music CDs, and audio files of speeches, or content students
create themselves, such as podcasts, movies, photos, or slide presentations. All of
these types of files can be synced to an iPod for students, their families, and others
to share. With the addition of a small voice recorder, the iPod is also a tool for
producing content, such as for recording interviews for a family history slide
presentation or reading samples to evaluate student progress.

This section describes different types of education content that are available for use
with iPod and iTunes as well as how you can use the tools that come with a Mac to
produce your own content to use with iPod.

Finding and Using Podcasts, Audiobooks, and Other
Media 
Podcasts, speeches, audiobooks, and more are readily available from the Internet as
well as on CDs and from other sources.

Subscribing to Podcasts

Setting Up and Personalizing a Mac for Diverse Learner Needs 10
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A wide range of educational content is being developed for and delivered via
podcasting. With podcasts, you and your students can subscribe to free audio or
video content that is available on the Internet. Once you subscribe to a podcast,
each new episode gets downloaded to a computer automatically. A podcast is
similar to a radio or TV show, but a podcast can be listened to or viewed at any
time. The underlying technology used for podcasts, called RSS (for Really Simple
Syndication), is capable of containing any type of media, including audio, video,
graphics, and more.

The material in podcasts can be anything from curriculum-related presentations to
professional development series in which educators share content and best
practices. Podcasts give students access to educational content such as recorded
lectures, foreign language lessons, and biology demonstrations. Podcasts come in
many varieties—everything from news, music, or talk shows, to readers’ theater
shows produced by students from around the globe. You can find professionally-
created, free podcasts from media companies such as NPR, CNN, and Discovery
Channel, as well as material posted from K-12 and university classrooms.

One of the best sources for education-related podcasts is the iTunes Store. These
podcast subscriptions are free, and there is an entire section of content just for
education. You’ll find shows produced by students like Radio WillowWeb by the
students at Willowdale Elementary School in Omaha, Nebraska and professional
development materials from other educators, including the Apple Distinguished
Educators podcasts Cut to the Core: Essential Podcasts for Educators and Conference
Connections, with highlights from technology conferences. Many podcasts are
designed to help with learning a new language, such as The French PodClass.
Podcasts from museums are also readily available on the iTunes Store, such as
Museum Tours, a collection of podcasts from museums around the world.

Using iTunes and iTunes Store, you and your students can browse, preview episodes,
subscribe to, and download podcasts. The podcasts can also be synced to iPod for
listening and learning while on the go. You and your students can also create and
post podcasts to the iTunes Store. (See “Producing Podcasts with GarageBand” later
in this guide.)

In addition to finding and locating podcasts via the iTunes Store, you can also
subscribe to podcasts from other websites, such as from sites for museums,
government agencies, or other educational institutions.

iTunes displays podcasts you’ve subscribed to in the Podcasts section in the iTunes
library Source list. Just click Podcasts in the iTunes Source list to view the podcasts
in that iTunes library.

To subscribe to and play a podcast from the iTunes Store, follow these steps:

1 Open iTunes, then click iTunes Store (below Store in the Source list).

2 Click Podcasts below iTunes Store in the iTunes window.

A selection of podcasts is displayed.

3 Click a podcast to learn more about it.

You can locate many more podcasts either by browsing categories or by searching
for a specific topic.

Education Content for Use with iPod and iTunes 11
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4 To browse the collection, click a category in the Categories list on the left of the
Podcasts window. Click the Education category to view educational podcasts, which
include subcategories of Educational Technology, Higher Education, K-12, Language
Courses, and Training.

5 To search for podcasts by a topic or name, enter one or more words in the Search
iTunes Store field in the upper-right corner of the iTunes window, then press Return.

All of the contents of the iTunes Store are searched, not just podcasts, and the
research results are organized by music, audiobooks, and podcasts.

6 When you find a podcast to which you want to subscribe, click the Subscribe
button.

7 In the dialog that appears, click Subscribe.

Future episodes of that podcast will be downloaded automatically to your iTunes
library.

8 To play a podcast, click Podcasts under Library in the iTunes Source list.

The podcasts in your iTunes library are displayed.

9 Click the podcast you want to hear, then click the Play button (the triangle in the
upper left of the iTunes window).

For an overview of how podcasting can be used to support learning, visit
www.apple.com/education/podcasting. This site offers tutorials on how you can
create, distribute, and access podcasts, as well as great sample podcasts and other
resources, including Apple’s Learn to Podcast series.

Locating Audiobooks for Use in the Classroom
Many students benefit from having books on audio, and delivering books with iPod
provides a portable and exciting way for students to listen and learn. If you already
have audiobooks on CD in your classroom or school library, you can import those
books into iTunes and then sync them with an iPod. A large selection of audiobooks
is available for purchase via the Internet. You download them to your computer’s
iTunes library and then sync them to iPod.

To locate audiobooks available from the iTunes Store, go to the iTunes Store by
clicking it in the Source list in iTunes. Click Audiobooks under iTunes Store in the
main iTunes Store window. The available audiobooks, such as Lord of the Flies,
Macbeth, and Fudge (by Judy Blume), are organized by category. You can locate
audiobooks by entering a title or author in the search field at the top right of the
iTunes window, and then pressing Return or Enter.

The website www.audible.com also offers a wide choice of downloadable
audiobooks for purchase, from classics to new releases.

For information about using audiobooks on iPod, including how to adjust the book’s
play speed, see “Appendix: iPod 101” later in this guide.

Education Content for Use with iPod and iTunes 12
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Locating Movies, Music, Speeches, and Other Media
In addition to podcasts and audiobooks, you can also use other types of existing
content with iPod and iTunes. You can browse through the iTunes Store to locate a
variety of other media to enhance your curriculum, such as documentary movies
and children’s music. For more information about using the iTunes Store, see
“Purchasing Education Content from the iTunes Store” later in this guide.

Creating Your Own Content 
iPod and iTunes offer easy access to many types of education content that you and
your students produce, from digital media projects created with iLife, to class
podcasts, voice recordings, slideshow presentations, and text files. The following
sections provide an overview of these types of media files.

Producing Digital Content with iLife
Apple’s iLife suite is unparalleled in allowing you and your students to easily create
media-rich lessons and projects. Producing digital media projects gives students a
compelling way to learn and express their knowledge in any curriculum area. With
iPod, students have a tool to share those projects. The iLife suite, which comes free
on every new Mac, includes these applications:

• iMovie HD can be used for creating digital movies and video podcasts that can then
be exported to an iPod for viewing.

• iPhoto can be used for importing, organizing, editing, and sharing photos. These
photos can be used in iMovie HD projects and Keynote slide presentations and
added to podcasts created in GarageBand. The movies, presentations, and podcasts
can be synced to iPod as well as albums of photos in iPhoto.

• GarageBand can be used to create and record music and podcasts, which can then
be exported to iTunes or published on the Internet with iWeb and a .Mac account.* 

• iWeb can be used for creating webpages, blogs, and podcast feeds. Once published
on the Internet, others can subscribe to student podcasts and access other student
work.

• iDVD is used for producing DVDs to store and share digital media projects.

All of these applications are simple to use and interface seamlessly with one
another. For example, a podcast created in GarageBand can be used on a webpage
created in iWeb. Photos in iPhoto and music files in iTunes are easily imported into
iMovie HD.

For more information about using iLife in the classroom, including lesson plans,
tutorials, and tips, visit: www.apple.com/education/ilife.

Education Content for Use with iPod and iTunes 13
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Producing Podcasts with GarageBand
Creating a podcast with GarageBand is an excellent and easy way to get students
started in developing content for the iPod and understanding the iPod interface. It’s
also a great method for students to express what they’ve learned. For example,
students could create a weekly podcast recap of what they’ve studied for the week.
This could be distributed to parents and the general public as a way to showcase
the quality work occurring in your classroom or school. Students could create a
podcast of poetry readings or book reports, providing motivation for writing in the
classroom. They could also publish summaries of science projects or reports of
school sporting events.

All it takes to create a podcast is GarageBand (included with iLife), a computer with
a built-in microphone, and your students’ creativity. To get started, students open a
new podcast file in GarageBand. They click simple controls to start, stop, and play
back recording, then add sound effects, jingles (short music snippets designed for
podcast use), and other music. GarageBand will automatically adjust the sound
quality and volume levels. Students can also create podcast artwork by adding
photos or other images from an iPhoto library. This can enhance the podcast and
help to tell the story. Students could even add hypertext links that send listeners to
relevant websites. Students can then publish the podcast to the iTunes Store, send
their podcast episode to iWeb and publish it on the Internet with a .Mac account, or
add it to a school intranet.

Education Content for Use with iPod and iTunes 14
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Before students begin creating podcasts themselves, you may want to review or
share with the class some examples of podcasts other students have created. A few
of these are listed below.

• Radio WillowWeb: Willowdale Elementary School students in Omaha, Nebraska have
a lot to share about what they learn!
www.itunes.com/podcast?id=73800253

• Room 208: A podcast by third and fourth grade students in Wells, Maine. Students
share their work, reflections on learning, interviews, Reader’s Theater, and more.
www.itunes.com/podcast?id=73330439

• A School in the Coulee: Longfellow Middle School students in La Crosse, Wisconsin
produce this podcast on topics from literary adaptations to the continent of Africa.
www.itunes.com/podcast?id=79169064

• Podcast Central: This comprehensive collection of podcasts is produced by the
students, teachers, and administration of Mabry Middle School in Marietta, Georgia.
www.itunes.com/podcast?id=73888013

For more information on podcasting, visit: www.apple.com/education/podcasting.

Using iPod for Voice Recording 
With a small third-party recorder that connects to iPod, you and your students can
record memos, lectures, interviews, and conversations in full stereo. Audio files can
be reviewed later on an iPod by using the headphones or by syncing the audio files
with a computer and reviewing them in iTunes.

The possibilities are endless—students can share personal notes, capture field trip
notes, track small group discussions, or conduct interviews to use in a documentary
film or podcast. Reading samples can be captured for assessment purposes or for
students to use for self-reflection. Students learning a foreign language can record
themselves to practice speaking and fluency. You can use iPod and a voice recorder
to dictate instructions for science labs, lesson plans, and research notes, or to record
“to-do” lists as you think of them. iPod with a voice recorder can also be used for
recording staff or parent meetings instead of transcribing them. You can share what
was recorded by posting the audio file on a website.

When you connect your iPod to a computer, your voice recordings are transferred
from the iPod to the computer and placed in the Voice Memos playlist in iTunes.
These files are date and time stamped, which allows them to remain separate. You
can rename them once they are transferred to the computer for easier identification.
If students are using multiple iPod recorders on the same date, this could result in
several recording files that share the same date and similar times. To make it easier
to identify voice recording files, it’s a good idea to have each student say his or her
name at the beginning of a recording. That will streamline renaming the files once
they are downloaded.

The recorded audio files can be edited in GarageBand, saved in iTunes, and used in
other projects, such as for a narration in a podcast created in GarageBand or an
iMovie HD movie project. (See “Accessorizing iPod” later in this guide for information
about specific voice recorders.)

Education Content for Use with iPod and iTunes 15
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Sharing Presentations with iPod
Another great feature of iPod is the ease with which you can share and view
presentations that you and your students produce. For example, students could use
a presentation to share their findings from a lab experiment or to demonstrate what
they have learned about a period in history. Using Keynote or PowerPoint, students
can create slides with text, charts, tables, photos, their own artwork, and movies.
They can add animation effects and transitions to enhance their presentations. They
can then easily share the presentations they’ve created on an iPod by exporting it in
the QuickTime movie format and then importing it into iTunes and syncing it to
iPod. Connecting the iPod to a presentation device, such as a projector or television
monitor, makes presentations incredibly portable. This is easily accomplished with an
AV cable, such as the Apple iPod AV cable. (For more information about the Apple
iPod AV cable, see “Accessorizing iPod” later in this guide.)

Creating Notes for Viewing on an iPod 
The iPod Notes format is a powerful tool in the classroom that can be used for
displaying text on an iPod. This feature gives you an additional way to present
information to students—with the written word as well as with sound and images.
For example, students could view new vocabulary words used in a foreign language
podcast or read the text of a famous speech. You add a text file to the iPod by first
creating a word-processing file and then adding the file to the iPod Notes folder, as
described later in this section.

This text can be interactive as well. You can add links to these text files that when
selected, take students to other content on the iPod, such as music, images, movies,
or other audio. For example, an astronomy student using an iPod could scroll
through the names of Jupiter’s moons, choose Europa to read text about it, and
then select a link to hear a description and see a telescopic photo. Or a written
guide to historic places could have links to images and interviews with community
members about these sites.

Before you add a text file to iPod, you need to be sure the iPod is set up to be used
in disk mode, which means that it can be used as a hard disk to store and transport
files. If you have set up the iPod to sync manually with iTunes, it is ready to be used
as a hard disk. If the iPod is set to sync automatically, you need to select the “Enable
disk use” option in the settings for the iPod. For information about manual and
automatic syncing and setting up the iPod for disk use, see “Adding Content to iPod
Using iTunes” later in this guide.) 

To create a text file in TextEdit and add it to iPod, follow these steps:

1 Open a new TextEdit document and create a text file. (TextEdit is included on every
new Mac computer, but other word-processing applications that can save text in the
.txt format can be used as well.)

2 Choose Format > Make Plain Text, then save the document.

The document is saved in the .txt format (the format needed for using the Notes
feature on iPod).

3 Connect the iPod to your computer.

Education Content for Use with iPod and iTunes 16
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4 Double-click the iPod icon on your desktop. Locate the Notes folder in the window
that appears.

5 Drag the text file that you want to view on iPod to the Notes folder to 
copy it.

6 To view this file on the iPod, navigate to Extras > Notes and select the file you want
to view.

For more information and step-by-step instructions about this learning component
of the iPod, see Using iPod as a Tour Guide at
http://developer.apple.com/hardwaredrivers/ipod/iPodNoteReaderGuide.pdf

Additional Resources for Creating Content
Mogopop is a free web-based service where members and visitors can create,
publish, and download digital media content for iPod. It has a project builder where
you can add text, photos, audio, and video to a project. When completed, the project
is published on the Mogopop site for the public to download. As an example, you
can download an Edgar Allen Poe poetry anthology that was created using the
Mogopop tools. To learn about Mogopop, go to www.mogopop.com.

If you don’t want your content to be freely available to the public as with the
Mogopop service, you can create content for iPod and iTunes by using
TalkingPanda’s iWriter software. iWriter lets you create projects with text and audio
such as quizzes, lectures, and eBooks. For more information about using iWriter, go
to www.talkingpanda.com/iwriter.

Purchasing Education Content from the iTunes Store
As described earlier in this guide, the iTunes Store provides a wide variety of
education content available for purchase, such as classical music, educational TV
shows, and documentary movies. To purchase items from the iTunes Store, you need
an Apple account, which you will already have if you have ordered items from the
Apple Store or have a .Mac account. If you have an AOL account, you can use that to
order from the iTunes Store. To create an Apple account, in iTunes, choose Store >
Create Account, and then follow the onscreen instructions.

Before making purchases, it’s helpful to select the iTunes Store options you want
from the Store pane of iTunes preferences. (Choose iTunes > Preferences, then click
the Store button.) 

Once you have an Apple account, you can make the purchasing process easier by
selecting the “Buy and download using 1-Click” option, which lets you buy items
from the iTunes Store and download them to your iTunes library with a single click
of a button. Or you may prefer to avoid accidental purchases by selecting the “Buy
using a Shopping Cart” option, which lets you buy music, news, and videos in a
more traditional online purchase environment. (You might not want to use the 1-
Click option on the student computers.)

Once you have purchased content, it can be viewed and listened to on the
computer or synced to an iPod for learning on the go.
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Adding Content to iPod Using
iTunes

The first time you connect an iPod to a computer, the iPod Setup Assistant appears
and guides you to name the iPod and choose whether you want to automatically or
manually sync the content in iTunes to iPod. (Syncing means to copy the content in
an iTunes library to an iPod.) If you set iTunes to automatically update the content,
when you connect the iPod to the computer, the content in your iTunes library is
automatically updated on the iPod. You can choose to automatically sync all of your
content or just some of it, such as particular playlists or photo albums. When you
select the manual syncing option, each time you connect the iPod to a computer,
you drag the content that you want from the iTunes library to the iPod. This section
describes how to set up both of these options. (You can change options at any
time.)

Note: Your computer should have come with iTunes pre-installed if you have a Mac.
However, if you have a PC or you need the latest version, go to:
www.apple.com/itunes/download.

18



Getting Started: A guide for using iPod and iTunes for teaching and learning

Syncing iPod Automatically
If you set iTunes to automatically update songs and playlists, when you connect the
iPod to the computer, iTunes opens and the content in that iTunes library
automatically syncs to your iPod. Even if you set up iPod to manually manage
content, you can change to automatically sync content at any time.

To set up an iPod to automatically update content, follow these steps:

1 Connect the iPod to your computer. iTunes should open automatically. If you set
iPod settings to not open iTunes when you connect the iPod, open iTunes manually.

2 Click the iPod icon under Devices.

3 From the iPod Settings window that appears, click the Summary tab if it’s not
already selected.

4 To set up the iTunes library and the iPod to mirror the same audio and video
content, make sure “Manually manage music and videos” is not selected.

5 If you want to be able to use the iPod as an extra hard disk to store or transport files
or if you want to be able to add text notes to the iPod, select “Enable disk use” in the
Summary pane.

6 To sync the library’s music, click the Music tab, select “Sync music,” then select the
“All songs and playlists” button to add everything from the iTunes collection to the
iPod. Or, click the “Selected playlists” button, and then select the playlists you want
to include from the list of playlists. If you want to include music videos on the iPod,
select “Include music videos.” If you want to include the album artwork, select
“Display album artwork on your iPod.”

7 To sync the library’s movies, TV shows, and podcasts, click the Movies, TV Shows, and
Podcasts tabs and select to sync all the titles in that category or just selected ones.

8 To sync the library’s Photos, click the Photos tab and select the options you want.

9 To sync Address Book contacts and iCal calendars, click the Contacts tab. To have
your contacts available on the iPod, select “Sync Address Book contacts,” then select
either “All contacts” or “Selected groups.” To sync your iCal calendars, select “Sync iCal
calendars” and either “All calendars” or “Selected calendars.” (For more information,
see “Syncing Calendars to iPod” later in this guide.)

10 When you’re finished, click Apply.

iTunes starts loading your iPod with the selected content. This can take several
minutes if the iTunes library is large.

11 To start playing the content on the iPod, disconnect the iPod from your computer
by clicking the small eject button to the right of your iPod icon in the Source list of
iTunes. When the icon disappears from iTunes and the iPod no longer displays the
“Do Not Disconnect” message, you can safely disconnect the iPod.
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Syncing iPod Manually
If you are managing a classroom set of iPod players, you may want to choose to
sync the iPod players manually so that you can control what is loaded on each iPod.
This way, you’ll know exactly what content the students will see. In manual mode,
you can add songs, playlists, podcasts, and audiobooks by simply dragging the
content you want onto the iPod icon in the iTunes Source list. (For more information
about how to administer the student iPod players, see “Managing iPod and iTunes
for Student Use” later in this guide.)

To set iTunes to manually update songs, playlists, audiobooks, videos, and podcasts
on iPod, follow these steps:

1 Connect the iPod to the computer. Open iTunes if it does not open automatically.

2 Click the iPod icon under Devices in the Source list of iTunes.

3 In the iPod Settings window that is displayed, click the Summary tab if it’s not
already selected.

4 Select the “Manually manage songs and videos” button.

This deselects all sync options in the Music, Movies, and TV Shows tabs. Selecting
this option also enables the “Enable disk use” option that allows you to use the iPod
as a hard disk and add text notes to the iPod.

5 To manage podcasts, photos, and contacts manually, click the Podcasts, Photos, and
Contacts tabs and deselect each of their sync options.

6 Click Apply.

To manually add content to any iPod model, follow these steps:

1 Connect the iPod to the computer. If iTunes doesn’t automatically open after you
connect it, open iTunes.

2 To add songs or audiobooks from the iTunes library, click Music in the Source list,
select one or more items you want (or select multiple songs and audiobooks by
Command-clicking items on a Mac or Control-clicking items in Windows), then drag
them onto the iPod icon in the Source list. To add a playlist, select the playlist in the
Source list and drag it onto the iPod icon in the Source list.

3 To add podcasts, click Podcasts in the Source list. Then either drag a podcast title to
the iPod icon in the Source list to copy all of the downloaded episodes, or click the
disclosure triangle next to any podcast title and drag any podcast listing to add
individual episodes.

4 When you’re ready to start using iPod, disconnect it from the computer by clicking
the small eject button to the right of the iPod icon in the Source list. When the icon
disappears from iTunes, you can safely disconnect iPod.
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Managing iPod and iTunes for
Student Use

This section will help you understand how best to manage iPod and iTunes in your
classroom. Because iPod is designed to be paired with one computer or user
account, the way you use iPod in the classroom will more than likely determine how
you decide to set up user accounts. Keep in mind that content from iTunes and
iPhoto libraries is copied to iPod from a computer.

Getting Students Up to Speed
Most students will not need instruction on how to use an iPod, but you might want
to review specific items such as how to access different types of content and how to
start and stop an audiobook or a movie. By attaching a projector to a computer, you
can demonstrate to the class how to use iTunes and the other applications they will
be using, such as GarageBand for creating a podcast. If you have access to a
document camera, this tool is an excellent way to demonstrate the features of the
iPod itself. If you don’t have use of a document camera, you can create a makeshift
one by connecting a camcorder to a projection device.

Setting Up Student Groups and Accounts
Mac OS X is the current version of Apple’s operating system. Mac OS X is a multiuser
system designed to create distinct spaces for each user’s work. With Mac OS X, each
computer has at least one “administrator” account used for installing software,
changing settings, and setting up additional user accounts. Each user has his or her
own iTunes library, as well as a Documents folder and other folders set up to store
different types of files.

Once a user account is set up on a computer, the person using that account logs in
as that user and can only see that user’s files. Accounts are set up from the Accounts
pane of System Preferences. (Open System Preferences, then click Accounts. An
administrator clicks the plus sign to add a new user account.) To learn more, choose
Help > System Preferences Help when System Preferences is open or go to the Mac
OS X Support site at www.apple.com/support. The following sections describe
different ways you might want to set up the student user accounts on a Mac for use
with iPod players.
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Providing the Same Content for All Students 
If you want all of your classroom iPod players to contain the same content, one way
to do this is to set up a computer with two user accounts—an administrator
account for you and one student account that all students share. With this setup, a
student using the computer would log in with the student group username and
password. You would log in to that computer using the administrator account.

All of the students would share a common iPhoto and iTunes library. When an iPod
is synced with the computer, the content from the shared student account’s iTunes
and iPhoto libraries would be loaded onto the iPod player. Many teachers find
setting up a single student user account for use with classroom sets of iPod to be
the easiest way to manage and distribute content.

Providing Separate Content for Each Class 
If you have multiple classes using the same computer, you could set up one user
account for each class. If students save their work to individual computers rather
than to a server, separate class accounts would make it faster for students to locate
their work because the account would only include work saved by students in that
particular class.

Each class account would have its own iTunes and iPhoto libraries, which would
allow the content to be different for each class, such as one account for first year
French and another for AP French. This would allow you to sync the iPod players
with the content needed for each class.
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Providing Customized Content for Individual Students 
If you want to provide specific content for individual students, you can do this by
creating separate playlists in iTunes. You could set up one student group account to
sync all content to one main iTunes library as described in the previous section. You
can then provide individualized content for each student by creating a playlist for
that student that contains items to be used by that student on an iPod. If you set
the iPod players to sync manually, you can drag each student’s playlist to the iPod
he or she will be using. Playlists can also be used for special projects or for
organizing content by subject.

To create a new playlist in iTunes, follow these steps:

1 Choose File > New Playlist, or click the Add button (+) in the bottom-left corner of
the iTunes window.

2 Type a name for the playlist.

3 Click Music (or another item below Library) and then drag the item to the playlist. To
select multiple items, hold down the Command or Shift key while you click.

Another way to provide customized content for each student is to create one user
account for each student using the computer. Although such accounts take longer
to create initially, this is a good way to provide privacy for student work saved on
the computer. You may also want individual accounts when students need special
settings on the computer to accommodate learning or other disabilities. iTunes and
iPhoto libraries would be unique to each student account, and the iPod players
would be synced for individual student content using this type of setup.

Keeping Track of Student iPod Players
One of the most powerful aspects of iPod is that it is a portable learning tool. Like
textbooks, notebook computers, and other learning tools that may go to and from
school with students, you probably will want to asset tag the iPod players using the
same type of asset tags or barcodes you do for other items. If the library manages
them, you can use the same checkout system used for library materials.

If you are checking iPod players out from your classroom, you might want to use a
sign-in/sign-out sheet to help keep track of them. Along with asset tags, you might
want to consider numbering the iPod players to help you keep track of which iPod
is being used by which student. When you first set up each iPod using the iPod
Setup Assistant, you name each iPod. You can use these names when you set up
your system for checking out the student iPod players.

Another management idea is to purchase inexpensive small plastic containers and
put together an iPod “kit” containing an iPod, headphones, a voice recorder, and a
USB cable for checkout.
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Sharing iPod Players 
Along with checking out iPod players to students to take to and from school, there
are other ways they can be shared. If you do not have a class set of iPod players, you
can assign one iPod to a group of students, using a project-based learning
approach. You can also use an audio splitter, like the Griffin SmartShare Splitter, to
allow two students to share one iPod.

Even one iPod and voice recorder can be effectively used with a group of
students—simply pass the iPod from student to student, having them record a
reading passage for assessment or narration for a story. (For more information about
audio splitters and voice recorders, see “Accessorizing iPod” later in this guide.)

Restricting Access with Parental Controls 
iTunes has a specific setting that you can use for extra security, such as to restrict
access to explicit content from the iTunes Store. To select these options, choose
iTunes > Preferences, then click the Parental button. Select the options you want,
then click OK.
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iPod for Professional Development
and Other Uses

iPod and iTunes offer many other valuable uses for you as an educator and to
support learning in the classroom. For example, you can use iPod to access a wealth
of professional development resources, sync calendars and to-do lists to iPod, add all
contact information, and use iPod as an additional external hard disk.

Using iPod for Professional Development

For educators, there’s never enough time in the day, which is why using iPod for
professional development is such a great solution. The portability of iPod gives you
the ability to review and reuse development materials when and where it’s most
convenient. You can download professional development content to your iPod and
listen while you’re at the gym, driving to and from work, or doing chores at home.
You can learn new directives and techniques without waiting for the next face-to-
face training session.

Podcasting allows administrators to update faculty—even an entire district—in
minutes. With just a few clicks, professional development content can be delivered
automatically. It’s the perfect way to expand ongoing training programs without
straining district resources.

Many types of professional development content are available for iPod. An
abundance of educational resources, both commercial and free, are available from
the iTunes Store, including audiobooks and professional development podcasts.
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These materials can be synced to iPod for convenient learning on the go. For
example, you can check out professional development podcasts such as Conference
Connections from Apple Distinguished Educators, Learn to Podcast by Apple, and the
November Learning Podcast Series by Alan November, each of which can be
subscribed to free of charge from the iTunes Store. Using iPod, you are able to use
these professional development resources to increase your own learning.

Syncing Calendars to iPod
To keep track of important dates or school schedules, you and your students can use
the Calendar feature of iPod. You can create a class calendar with iCal (included on
every new Mac) or Outlook with due dates for projects, school holidays, field trips,
and other school activities. Then you can sync the calendar to an iPod to share with
the class. These calendars can also include the To-Do items to help you keep track of
important tasks. For more information, visit:
http://docs.info.apple.com/article.html?artnum=304685.

Adding Contact Information to iPod
If you’re using a Mac, you can readily sync contact information in Address Book, such
as phone numbers and email addresses, with your iPod. This means you could add
an Address Book entry for each of your students by downloading information from
your student information system (complete with photos) and store that information
on your iPod for easy retrieval. If you’re using Windows, you can easily sync contacts
from Microsoft Outlook or Outlook Express. Alternatively, you can transfer contact
information from any Mac or Windows contacts manager that can export (or
supports) contacts in vCard (.vcf ) file format, such as Palm Desktop, Microsoft
Entourage, and Eudora. With this feature, you can have on-the-go access to student
information and important contacts. It would also aid students who are working
together on a group project to have instant access to each other’s contact
information. For more information, visit:
http://docs.info.apple.com/article.html?artnum=304685.

Using iPod as a Hard Disk
The iPod is also valuable as an external hard disk—you can use it to transport files
between school and the classroom and to store students’ digital media projects.
Before you can use an iPod as a hard disk, you need to make sure the “Enable disk
use” option is selected in the Summary pane of iPod settings in iTunes. (For more
information, see “Adding Content to iPod Using iTunes” earlier in this guide.) When
this option is selected, an icon for the iPod appears on your desktop when you
connect the iPod to your computer. Double-click the icon and an iPod window
appears. To add files to your iPod, just drag them to this window. You can create new
folders in the window, just as with any other Mac windows, to organize your files.
When you connect the iPod to a different computer, just drag the files or folders to
the location you want on that computer. To delete files or folders from the iPod,
drag them from the iPod window to the Trash.
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Accessorizing iPod 

Many types of helpful accessories are available to enhance the use of iPod for
teaching and learning. For details about iPod accessories, go to:
www.apple.com/education/products/ipod/accessories.html.

Voice Recorders
By adding a small voice recorder to an iPod, you and your students will have a
portable recording device with many uses, such as recording reading assessments or
notes on a field trip. See “Using iPod for Voice Recording” earlier in this guide for
more information about recording with iPod.

Belkin TuneTalk Stereo. The Belkin TuneTalk Stereo recorder attaches to the iPod
dock connector and has two high-quality omnidirectional microphones for
recording with an iPod in full stereo. It also includes a stand for hands-free
recording.

XtremeMac MicroMemo. This audio recorder lets you and your students capture
high-fidelity audio directly on an iPod. It attaches to the iPod dock connector and
includes a flexible, detachable microphone. Powered by the internal battery of the
iPod, MicroMemo also includes a built-in speaker for instant playback without
headphones.

Speakers
External speakers are helpful when you want to play back content from an iPod or a
computer for the whole class to listen.

iPod Hi-Fi. The iPod Hi-Fi is a compact sound system with an integrated Universal
Dock for iPod that produces sound powerful enough for a classroom. You can use
iPod Hi-Fi with iPod or with an external audio source, such as a computer or DVD
player.

JBL Creature II Speakers. The JBL Creature II subwoofer and satellite speakers
deliver high-quality and deep sound in a classroom or auditorium. They support all
iPod models and all computers with a headphone port.

Altec Lansing inMotion iM11. This is a portable sound solution that allows content
on an iPod to be shared in any location.
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Cases
The iPod comes with a sleeve to protect it when not in use. However, if you plan to
have students take the iPod players outside of the classroom, you might want to
consider purchasing a more sturdy case, such as one of the following:

Contour iSee. The Contour iSee provides all-around protection in a snap-on design
case. The two halves of the iSee case snap together around the iPod, adding
minimal bulk without obstructing viewing or controlling the iPod.

Speck ToughSkin. For students who are tough on their equipment, the Speck
ToughSkin offers rugged protection for the iPod. It also includes a belt clip and
screen protector.

Other Accessories
Apple iPod Camera Connector. The Apple iPod Camera Connector provides a fast,
easy way to transfer images from a digital camera to an iPod. You plug the iPod
Camera Connector into the iPod dock connector, plug in the camera’s USB cable,
and the images are transferred to the iPod.

Apple iPod Power Adapter. You can charge your iPod battery by connecting your
iPod to an Apple iPod Power Adapter using the FireWire or USB cable that came
with your iPod. Then plug the adapter into a working electrical socket.

Kensington Digital FM Transmitter/Auto Charger for iPod. Stuck in traffic and
want to use that time for your own benefit? You can listen to music or professional
development podcasts while you’re driving. This transmitter/auto charger plays and
charges your iPod using your car’s FM radio and DC power source.

Griffin SmartShare Splitter. Not enough iPod players to go around? The Griffin
SmartShare Splitter allows two students to share one iPod, while letting them each
use their own pair of headphones and volume controls.

Elmo Document Camera. The Elmo TT02 Portable Document Camera allows you to
demonstrate iPod controls and features to your entire class as you get them familiar
with the device. It has power zoom, auto focus and contrast, and RCA/RGB outputs.
For more information, visit www.elmousa.com.

iPod AV Connection Kit. Bring photos, movies, and Keynote presentations to the big
screen. This kit includes everything you need to connect iPod to a projector or TV
and keep it charged.
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Curriculum Ideas, Success Stories,
and Lesson Starters 

There is no shortage of ways you can use iPod and iTunes to support teaching and
learning. This chapter provides ideas for their use in the classroom, some profiles of
actual success stories, and several lesson starters.

Enhancing Classroom Learning with iPod and iTunes
This section provides suggestions for just some of the ways you can enrich your
curriculum with the use of iPod and iTunes.

Supporting Second Language Acquisition
Students can use the iPod to assist with learning a foreign language. They can listen
to audio recordings to learn words and phrases, hearing the proper pronunciations
on the iPod. They can also record themselves using iPod and a voice recorder or
with GarageBand to practice the language and improve their fluency. Using the
lyrics and album art information in each audio file can further reinforce the learning
of another language. For example, if the text of what a student is listening to is
pasted into the Lyrics portion of the audio file, students can see and hear the
content. The images included with the audio file as “album art” provide a visual for
the audio file being listened to.

Building Reading Fluency
Struggling readers do not know what they would sound like as a fluent reader. You
can record students who are struggling with reading in GarageBand as they read a
passage. Then edit the recording by eliminating pauses and miscues so that the
student sounds as fluent as possible. Send the edited recording to iTunes and sync
with an iPod. Let the student listen to himself or herself reading naturally—that
recording then becomes the bar the student strives for when reading aloud.

Motivating Readers with Audiobooks
Audiobooks can be purchased for use on the iPod, or older students can use an iPod
with a voice recorder or GarageBand to narrate and record books for younger
students to listen to, perhaps with each older student reading one chapter in a
book. The iPod can then become a “listening center” while the younger students
read the text. In this way, the child’s auditory and visual senses are receiving the
input. Some teachers find it helpful to have hesitant or struggling readers listen to
the first chapter of a book on an iPod so they can get “hooked” on the book, and
then have them read the rest of the book on their own.
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Reaching All Learners
iPod can be a supportive tool in the learning possibilities for students with special
needs. Using an iPod, students at all levels can listen to audiobooks, speeches,
foreign language samples, and podcasts. Students can also reinforce their auditory
learning by viewing slides, photos, and video as well as text files. Use of the iPod can
help visually impaired students access the curriculum via audio files. English
language learners, students who struggle with reading and writing, and students
who need auditory and visual input simultaneously for learning to “stick”—these
students will all be well-served by an iPod.

The iPod can be loaded with audio versions of your lectures, audiobooks, famous
speeches, Keynote presentations to use for homework support or test review, and
more. And with a voice recorder connected to the iPod, students can record many
types of audio files—for example, ELL students can record and play back English
dialogue, and students with literacy needs can record reading samples for
assessment or reading practice, or they can record notes if they have difficulty with
written note-taking.

Using iPod for Assessment
Oral language sampling is one way to evaluate the language of students with a
hearing loss or any language delay. Recorded speech and language can be analyzed
to know which grammatical structures and speech sounds the student has
mastered, as well as to identify new goals. A voice recording is often a more
accurate indicator of the communication ability of a student than evidence obtained
through formal tests, and the recordings can be used year after year to track student
progress. The teacher uses an iPod with a voice recorder to record a student telling a
story, describing a picture, sharing information about a favorite toy from home, or
talking about anything that will have the student leading the conversation. Next, the
recording is imported into iTunes to save in the student’s audio playlist. The teacher
can then use an iPod or iTunes to easily move to any point in the sample for ease of
use in transcribing and reviewing the student speech sample. These samples can
also readily be shared with parents or a student study team. Using an iPod and
iTunes for capturing and storing these voice recordings greatly simplifies the
process. For more detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10672

Learning from Other Educators: iPod Success Stories 
Educators across the country have had success integrating iPod into the curriculum,
resulting in higher student achievement. The following are just a few examples of
how iPod is being used to support teaching and learning.

iPod Helps Special Needs Students
At Louisa-Muscatine Elementary School in Letts, Iowa, special education students are
using iPod to assist with test-taking. Instead of needing the assistance of an onsite
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paraprofessional to read the questions aloud, students can grab an iPod, put on
headphones, scroll through the menu to find the test they need, and listen to the
questions being read to them as they see them on their test papers.

www.apple.com/education/profiles/louisamuscatine

Elementary Students Become Podcasting Pros
Room 208 at Wells Elementary School in Wells, Maine has some stars in the making.
These third and fourth grade students have been producing their own podcast for
quite some time, and it has a national following. Learn how podcasting has
transformed the education of these students.

www.apple.com/education/profiles/wells

iPod Personalizes Language Learning
At the Brearley School in Manhattan, New York, iPod has become an integral part of
language classes. The portability of the iPod allowed the school to utilize technology
to support the acquisition of a second language.

www.apple.com/education/profiles/brearley

Lesson Starters for Integrating iPod into Your
Curriculum
The project descriptions in this section provide suggestions for how you can enrich
your curriculum using iPod and iTunes. You can adapt these projects to meet the
needs of your classroom or use them as starting points to develop your own lesson
plans.

Sueños—Dreams: Immigration Stories
When families immigrate to the United States, it is challenging for students to learn
a new language and stay motivated in school. When students tell their stories of
immigration, however, they all have the same theme: they were here in search of a
better life. Hence, the name Sueños.

In this project, English language learners (ELL) are assigned a lesson that focuses on
reflection, reading, writing, oral language development, and presentation skills. The
students work individually to script their story of their journey to this country and
create a short presentation movie in iMovie HD. Students have the opportunity to
discuss their experiences and memories of leaving their native country, but also
include thoughts, ideas, and dreams of coming to live in the United States and
coming to school here. Students use an iPod and a voice recorder to create
recordings of their reflections in both English and their native language, such as
Spanish. The audio files are added to the movie as a narration track. They add
appropriate images to illustrate each point. With this project, ELL students use an
iPod and other technology tools to motivate and assist them in developing their
oral language skills. The project incorporates multiple intelligences through the use
of text, audio, and image files.
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Walking Tour of the School or Community
In this project, students work in groups to create audio tours of their school or
community. Students use an iPod and a voice recorder to record commentary and
sounds at various places on the tours. They take photos of the various stops to
illustrate the commentary. They then combine the audio and photos with music and
any additional narration in GarageBand to create enhanced audio files for each
episode. Each final mix can be exported back to the iPod for use as an audio tour
guide for other visitors or can be published as an enhanced podcast for
downloading by community members. Audio tours can focus on historical aspects
of the community and involve the local historical society as a community outreach
project. Audio tours of the school are a great way to familiarize prospective and new
students with all of the wonderful aspects of your school. The project provides a
team approach to learning that caters to a variety of learning styles within each
team. The use of the iPod allows easy recording and capture of information, sounds,
and reflections and is an excellent way to share the students’ work.

Morning Announcements Podcast
In this project, a team of students creates a regular podcast of the school’s morning
announcements. Regular features such as a “Word of the Day” or “Joke of the Day”
can be added to further engage students. Audio announcements and banter are
recorded using an iPod and a voice recorder. The audio is then combined with
relevant photos in GarageBand to create an enhanced audio file. Using iWeb, a
regular podcast is created and posted. Staff, students, and parents can subscribe to
the Morning Announcements podcast and stay up to date with relevant information.
The project encourages a team approach for a regular group of students and caters
to many different learning styles.

Oral Histories
During a course of study in American history, students investigate the theme of
what it means to be American in a pluralistic society. One way students can explore
this question is by conducting oral histories with a family member and creating a
presentation of the interview. After a discussion about what it means to be an
American, students use an iPod and a voice recorder to interview a family member.
They then combine the interview with old photos of that relative in iMovie HD and
create a short video history about that person. The final movies are presented to the
class. In this way, students begin to develop a better understanding of their own
family history as a means for framing a discussion and an understanding of who
they are themselves. For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10667

iPod Reporters
In this project, students explore the basics of news reporting and gain an
understanding of why news is news and what their responsibilities are as news
gatherers. Students then plan a class newspaper. After determining topics for
articles, students head out, equipped with an iPod and a voice recorder, to interview
their sources. They download their interviews to iTunes when they return to class.
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They then compose their stories and complete and distribute their newspaper.
Using an iPod to record interviews for a newspaper story allows students to
concentrate on an interview while it is happening rather than trying to take notes as
they listen. This is especially helpful for younger students or those who face
challenges with hearing, writing, or attending to multiple tasks. When the interview
is over, students can listen to it again and again, allowing them to include accurate
quotes and details in their stories. For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10669

Digital Science Experiments
Students sometimes find it difficult to conduct science experiments, especially if
they are visual learners and have a difficult time with written or oral instructions. By
using recordings of the teacher’s instructions and student observations combined
with photos of an experiment’s progress, all students can review and observe what
occurred. The teacher uses an iPod and a voice recorder to provide experiment
instructions to small groups of students. Students listen to the directions first, then
they observe and record their experiment steps and results using a digital camera
and an iPod. The images and audio are then combined in an iMovie HD project that
can be exported to an iPod to share with others. This lesson can be applied to any
science experiment. It’s a great way to reinforce student learning and to share
experiments with students who weren’t there.

For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10666

Field Trip Tours
This project is used in conjunction with a class field trip designed to support subject
content taught in class—for example, the class could visit an Asian art museum
when studying China or a science museum when studying biology. On their field
trip, students use an iPod with a voice recorder to capture their thoughts, reflections,
and new learning on the museum and the exhibits they visit. They also take photos
with a digital camera. Upon returning to school, they combine the audio and photos
to create a guided tour in iMovie HD to share with others. The movie can also be
exported for use on an iPod, thus making the tour even more portable. Using audio,
images, and an iPod, students create a series of guided tours through a museum,
creating a virtual museum for others to access. The student reflections serve as a
way to allow students unable to attend the field trip to see what resources are
available in the community and make connections to courses of study in the school.
The tours also help teachers prepare subsequent classes for trips to the same
museum. These student-created tours can even be shared with the museum itself as
a community outreach project.

For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10663
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Learning Math with Music
Students need to learn number facts. Many students learn these faster when they
can use mnemonics, rhymes, and songs. In this lesson, students work in groups to
create their own rhymes and songs for an entire family of math facts. Individual
students record their math facts creations using an iPod and a voice recorder. The
class will then have a complete collection of math rhymes that can be used in class
or burned to a CD for students to use at home. Students love to create their own
memory rhymes and songs, which allows them to personalize math facts. The
portability of the iPod can help with developing these math skills by allowing
students to listen repetitively to the math facts inside or outside of the classroom.

For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10668

Radio Show
The War of the Worlds radio show rocked the nation when it first aired. At the time,
the nation’s news and entertainment came over radio waves. After reading and
listening to several radio dramas, student groups write a radio drama based on an
event or a period in history. Students write commercials that are appropriate for the
radio age and create sound effects. The radio shows are recorded using GarageBand
or an iPod with a voice recorder, imported into iTunes, and then shared with the
whole class. Writing and recording an original radio play allows students to
demonstrate an understanding of a historical event and the genre of the radio play.
The iPod is an effective tool for this process because it is portable and stores huge
amounts of data. Digitally recorded plays can be rebroadcast to individuals or
groups using the iPod.

For detailed instructions, visit:

http://edcommunity.apple.com/ali/story.php?itemID=10664

Kindergarten Animal Podcast
Kindergarten students study all kinds of animal life in science. They also are
developing their language skills, particularly those students for whom English is a
second language. After studying about a particular animal, students draw a picture
of the animal illustrating what they’ve learned. Those illustrations are scanned to
create a digital copy. The students then compose a few sentences to summarize
what they’ve learned about the animal. Using a voice recorder, they take turns
recording their sentences into an iPod or directly into a computer using
GarageBand. The group recording is then combined in GarageBand with the
scanned images, or in iMovie HD to create a movie file, so that as a particular
student is narrating, his or her illustration is displayed. The project can then be
shared as part of a class podcast with other kindergarten classrooms, parents, and
the community.
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Resources

Apple Websites
You can visit various Apple websites to learn more about iPod and iTunes. At these
sites, you will find tutorials, lesson plans, and many other valuable resources.

iPod in the Classroom
These websites provide information on all aspects of using iPod and podcasting in
the classroom:

www.apple.com/education/ipod

www.apple.com/education/podcasting

iPod at a Glance
This is a wonderful, rich tutorial of all things iPod:

www.apple.com/support/ipod101
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iTunes at a Glance
This tutorial provides everything you need to know about iTunes:

www.apple.com/support/ipod101/tunes

iTunes Support
The iTunes product support pages are packed with information to help you learn to
use iTunes and to assist you with any questions you may have. The support
resources include all iPod manuals and information about system requirements and
location of files. User discussions, articles, and all the latest versions of iTunes and
iPod updates can be found here.

www.apple.com/support/itunes

Apple Learning Interchange
Apple Learning Interchange (ALI) is a free online resource for educators that
showcases a wealth of content ranging from simple educator-created lesson plan
ideas to in-depth curriculum units, rich with digital media. You will also find valuable
resources, created by educators, for iPod and iTunes in the classroom or for
professional development. These resources are always free of charge, and new
content is added frequently.

http://edcommunity.apple.com/ali
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iLife in the Classroom
These sites provide lesson plans and other resources for using the applications in
iLife in the classroom:

• iLife in the Classroom
www.apple.com/education/solutions/ilife

• iMovie HD in the Classroom
www.apple.com/education/imovie

• GarageBand in the Classroom
www.apple.com/education/garageband

• iPhoto in the Classroom
www.apple.com/education/solutions/iphoto

• iWeb in the Classroom
http://www.apple.com/education/iweb

Apple Professional Development 
Apple Professional Development is a good aide for getting up to speed quickly with
your new classroom iPod players. The Apple Professional Development team can
design and deliver professional development that is customized to meet your needs.
There is a wide range of onsite and online training available. For example,
Podcasting in Education is designed to help you discover how easy it is to create,
distribute, and access podcasts. With this training, you can enhance your podcast-
creation skills and fully understand the power of podcasting in education. Topics
such as “Getting Started with the iPod and Podcasting,”“Digital Content on the Go,”
and “Podcasting to Engage Visual and Auditory Learners” are just some of the
training available to you through Apple Professional Development.

www.apple.com/education/solutions/apd

Third-Party Resources and Solutions

Reference Material for the iPod
You can use the resources on this site to listen to and view widely known content
on your iPod. Dictionaries, encyclopedias, study guides, test preparation materials,
and more are available.

www.ipreppress.com

Resources for Handheld Computing in Education
This site provides resources, including lesson plans, tutorials, and articles, for using
iPod and other handheld devices in schools.

www.learninginhand.com 
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Discovery Education’s unitedstreaming
Discovery Education’s unitedstreaming is the largest and most current K-12
standards-aligned digital video-on demand and online teaching service available
today and the only one scientifically proven to increase student achievement.
unitedstreaming contains content from top-notch producers such as Discovery
Channel, Scholastic, and BBC, and all video content is correlated with state and
provincial standards, giving teachers the ability to select just the right content to
satisfy local requirements. Items from unitedstreaming can be downloaded to a
teacher iPod for student viewing and anytime access.

www.unitedstreaming.com

ProfCast
ProfCast is a tool for recording and publishing a live Keynote presentation. The
complete presentation can then be published with RSS support and can be
downloaded to an iPod for portable viewing.

www.profcast.com/public/index.php

Nike + iPod Sport Kit
Childhood obesity is a serious health problem facing today’s students. Using the
Nike + iPod Sport Kit, students can become motivated about physical fitness and
learn some math and science while they’re at it. With this kit, the Nike+ shoe “talks
to” iPod nano, providing data about the workout. The sensor uses a sensitive
accelerometer to measure running and walking activity and then wirelessly transfers
the data on speed, distance, time, and calories burned to the receiver attached to
iPod nano. Real-time feedback from a male or female voice, plus the ability to listen
to music, make getting physically fit motivating for students. When iPod nano is
synced to iTunes, the data is transferred to a Nike website where students can
readily track their progress, analyze their current and past workout data, and
compete virtually with others around the globe.

For more information, visit www.apple.com/ipod/nike/.
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Appendix: iPod 101

This appendix provides some of the basics for how to use an iPod. You can refer to
this information when you demonstrate the iPod to the class.

Display

Any iPod with video capability can display navigation menus, audio file information
(filename, artist, genre, and more), photos, video, album art, playlists, volume, audio
file progress, the time, personal contacts and calendars, notes, a stopwatch, a screen
lock control, lyrics, and multiple world clocks.

iPod models with video capability feature a color 2.5-inch (diagonal) LCD screen to
help you navigate and control everything on your iPod. There are a variety ways of
to browse music, photos, and videos on an iPod—some of the most common
methods are by artist, album, song, or video name, or by your own personalized
playlists and photo albums. You can also use the display on your iPod to view and
change settings and to use a variety of extras such as contacts, calendars, notes, and
a stopwatch.

Click Wheel

This circular-shaped dial doesn’t physically spin; it’s a touch-sensitive pad (much like
a trackpad on a notebook computer) that senses movement as you glide your finger
across its surface. Just whirl your finger around the wheel to scroll through menus,
turn up the volume, move through an audio track, view your photo collection, and
more, depending on where you are on your iPod. The wheel also serves as a four-
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way controller; just press any control’s label (for example, “menu”) toward the edge
of the wheel to activate it. Unlike the wheel, these buttons aren’t touch-sensitive—
pressing a label on the Click Wheel actually pushes a corresponding button
underneath the wheel. You can play, pause, rewind, fast forward, and skip songs or
other items, or go to other menus using the buttons on the Click Wheel.

Turning iPod On or Off

You won’t find a dedicated switch to turn your iPod on and off. To turn it on, just
press any button. But first make sure that the Hold switch (on the top of your iPod)
isn’t engaged. To turn off iPod, press and hold the Play/Pause button until iPod turns
off.

Tip: To keep from accidentally turning on your iPod in transit and using battery
power, slide the Hold switch to the hold position to lock the controls. You can tell
iPod is in Hold mode when you see orange on one side of the switch.

Center Button

This button in the middle of the Click Wheel lets you choose the currently
highlighted menu item shown on the display. For example, if you’re in the Music
menu, you can whirl your finger around the Click Wheel until Songs is highlighted,
then press the Center button to go to the Songs menu and see all the songs on the
iPod. You can then highlight a song and press the Play/Pause button to hear it.

Menu Button

This button takes you back to the previous menu, similar to how the Back button in
a web browser takes you back to the previous page. For example, if you’re now
playing a song (after following the example for the Center button above), pressing
the Menu button returns you to the Songs menu. Press the Menu button again to
go back to the Music menu and one more time to return to the main (iPod) menu.

Previous/Rewind Button

When an audio or video file is playing on your iPod, you can start the file over by
pressing the Previous/Rewind button once or rewind through the current file by
holding down the button as long as you want. When listening to a song or
audiobook, you can go to the previous song or chapter in the list by pressing the
button twice. When browsing photos, pressing the Previous/Rewind button takes
you back to the previous screen of photos. If you are viewing a slideshow, press this
button to go back to the previous photo in the slideshow.

Next/Fast-forward Button

When a song or audiobook is playing on your iPod, you can skip to the next song or
chapter in the list by pressing the Next/Fast-forward button once. By holding down
the Next/Fast-forward button, you can fast-forward through any audio or video file
as long as you want. When browsing photos, pressing this button lets you skip to
the next screen of photos. If you are viewing a slideshow, press this button to skip to
the next photo in the slideshow.
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Play/Pause Button

When you choose a song, a video, an audiobook, or a podcast, pressing the
Play/Pause button either plays the selection or pauses it if it’s already playing. When
you’re viewing photos, you can choose any photo or album and press this button to
play a slideshow. Press it again to pause the slideshow. Remember that pressing and
holding the Play/Pause button also turns off the iPod.

Using Audiobooks on iPod

If an audiobook has chapters, you can press the Next/Fast-forward or
Previous/Rewind button to skip to the next chapter or the beginning of the current
chapter in the audiobook. You can also hold down the Next/Fast-forward or
Previous/Rewind button to move quickly through the book.

You can also set up an iPod to play audiobooks at speeds faster or slower than
normal with audiobooks purchased from the iTunes Store or www.audible.com. To
set an audiobook’s play speed, on the iPod, choose Settings > Audiobooks and
choose a speed. The play speed can also be adjusted while students are listening to
an audiobook. To do this, press the Center button until you see the Speed menu
item, and then use the Click Wheel to set Speed to Slower or Faster.
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